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This stand-alone document contains all the information you need to use the Exile II Character Editor, a 
utility for use with Exile II: Crystal Souls.

Exile II is a full-length fantasy role-playing game for Windows. Without a copy, this editor will do you little
good. On the bright side, this editor can improve parties created all version of Exile II.

Of special importance is the Registration Form, early in this document. You use it to pay for this Editor. 
Doing so gets you a    password which enables you to access all the features of the editor. To get to the registration 
form, go to the menu to the lower left that now says "About the Editor", and select Registration form.

The Exile II Editor is being marketed under the shareware concept. In the unregistered (i.e. free) version, 
you can add gold and food, heal your party, unkill dragons, move your party back to the start of the game, and take 
your party out of a town. Upon registering (i.e. paying), you will receive a code which will enable you to use all of 
the editors wonderful features. 

Click on the topics below to find out about...

Introduction and Registration:

What is Exile II?
How do I register?
Order Form
Getting 256 Colors

Using the Exile Editor:

Using the Editor/Getting started.
The Editor Menus
Adding Items
Adding Special Items
Credits



 What is Exile II ?

Exile II: Crystal Souls (Exile II for short) is a fantasy role-playing game. What is that? Well, its like a fairy 
tale or Tolkein novel, right there in your computer. You play a party of adventurers, a group of warriors and mages, 
thieves and holy people, going on quests, solving puzzles, doing good (and bad) deeds.

Exile II is designed to be as simple as possible to learn and play. If you, like many game-players, dislike 
reading the manual before jumping into the game, go ahead. It is recommended you read the Introduction (below), 
look at the illustrations to see what the buttons do, and, if you plan to design your characters from scratch 
(eventually a good idea), the section describing what the skills are. Also, the Hints For Getting Started section near 
the end of the manual contains some useful hints.

If you were lucky enough to have played Exile: Escape From the Pit, you will have a very easy time getting
into the swing of things here. The commands are basically the same, and the differences will be pretty easy to pick 
up as you go along.

Introduction:

The surface world is ruled by the Empire. That's what its called. The Empire. Not the Empire of Something,
or the Something Empire. Just the Empire. It's understandable. There's no need for elaborate names when there's 
only one game in town.

For many year, the Empire, in its arrogance, banished everyone it felt didnt fit in. Eccentrics, petty 
criminals, malcontents, they were all regarded as undesirable by the Empire. And, for many years, these unwanted 
citizens were send into Exile.

Exile was not just a status, however. It was (and is) an actual place. Exile is a network of hundreds of miles 
of caves and tunnels, forming an enormous, weblike labyrinth of warrens under the surface of the world. Kept lit my
magic, fed by fungus, and populated by the unending stream of humans (and humanoids) from the surface, the 
people of Exile struggled by as best they could for many years.

When Exile was established, however, the Empire, complacent and arrogant, made its greatest mistake. It 
send down several mages, powerful mages, who were on the wrong side of a political struggle. The winners, 
Emperor Hawthorne and the archmage Garzahd, were confidant that sending down these archmagi would not be a 
problem. They even thought that maybe their skills could later be harnessed, once they were beaten down by several 
years rotting in the sunless lands.

They could not have been more wrong.
Some of the exiled wizards, like Rone, and Solberg, and Patrick, were content simply building a better life 

for the Exiles. One of them, however, was named Erika Redmark. A harsh and vindictive incantatrix, she enlisted a 
band of adventurers, made tough by their years below, in a wild, dangerous, and eventually successful scheme. She 
wanted to assassinate Hawthorne, brilliant Emperor of the surface world.

Five years later, Hawthorne was killed in his own throne room.
The response was immediate, and vicious. First, the portal into Exile was closed. Nobody was to be sent 

through. Second, other portals were created, to remote areas of Exile. Soldiers were sent there, the finest soldiers in 
the Empires army. They was one mission: Vengeance. Not one citizen in this subterranean den of vipers was to 
escape alive.

Teleporting people into Exile is a difficult and draining task, and so Exile was not flooded with enemy 
troops. Still, the soldiers that did come down have already taken a quarter of Exile, and are moving steadily inward, 
taking cave after cave and city after city. If nothing is done, Exile will be doomed, and you with it.

Your job now is not to fight the Empire, however. You have just arrived at Fort Ganrick, a tiny fort in the 
farthest outskirts of your nation. Your job - help fight a den of sinister Nephilim (savage, feline humanoids). 
Thankless and dangerous work, and far from dealing with the great threat you all face. However, it is possible that 
circumstances will change. It is possible that chance will seize you and pull you into the center of the story you are 
all living. Perhaps something is about to happen that will shake everything apart, and you will have to put it back 
together again.

Perhaps that could happen. Youre about to find out...





 How to Register the Exile II Editor

Exile II is being marketed under the shareware concept. You can play the first half of the game at full 
functionality for free. To play the second half, you need to obtain a key (i.e. password) from Spiderweb Software.

PRICING:
        Exile II is $25, the Exile Editor is $9, the hint book is $7, and the Exile Bundle (all 3) is $35. 

You can register by credit card or by sending a check or money order.

CREDIT CARD: 
To register by credit card, call, fax or E-mail the Public Software Library and ask to register Product Code 

14535. Then say which Exile products you want. The phone numbers are
Toll-free: 1-(800)242-4775
Outside US: 1-(713)524-6394
FAX: (713)524-6398

E-mail address: CIS: 71355,470
Internet address: 71355.470@compuserve.com

 Be SURE to have your registration codes handy when ordering.
All major credit cards are accepted.

THIS NUMBER IS FOR ORDERING ONLY - THEY CANNOT HELP YOU WITH ANYTHING ELSE. 
MINIMUM CREDIT CARD ORDER $15 PLEASE

COMPUSERVE ONLINE REGISTRATION:
While on CompuServe, go to SWREG and search for keyword Exile. Select Exile II for Windows to 

register (make sure you register the Exile specifically marked as for Windows). You can only register the game and 
the $35 Exile II bundle through CompuServe.

IMPORTANT - After registering on SWREG, E-mail the registration codes for the game and/or editor to 
76463,1521. Ill get your keys back to you via E-mail right away.

BY CHECK OR MONEY ORDER:
Foreign orders are welcome. Pay with a money order in US currency. To print the order form, click on 

Order Form below and select Print from the menu above. Pay with a check (to Spiderweb Software) or money order 
(to Jeff Vogel).

HOWEVER YOU REGISTER, DONT FORGET YOUR REGISTRATION CODES. WE CANNOT REGISTER 
YOUR COPY WITHOUT THEM!

You should get your registration codes, along with full printed documentation, in the mail within 5-6 business days. 
If you include an E-mail address, your codes will be E-mailed to you as well. Please dont panic if your code doesnt 
arrive via E-mail - E-mail often gets lost or bounced.

Order Form



 Registration / Order Form

Make the check or money order payable to Spiderweb Software and mail to:    
Spiderweb Software.
PO Box 85659
Seattle, WA 98145-1659
(206) 789-4438

Please print NEATLY and impress us with your penmanship.

Last Name                                                                                            First Name                                                                      

Address                                                                                                                                                                                                              

City                                                                                                                  State                                          Zip                                    
 
Registration Code                                                                          To find out the registration code, select 'Shareware Info' 
from the title screen of Exile II. Without this, we cannot process your order.

Registration Code for Editor                                                                          To find out the registration code, select 
'Shareware Info' from the title screen of Exile II. Again, without this, we cannot process an order for an editor.

For registration by credit card, call 1(800)2424-PSL. Minimum credit card order is $15.

I would like to register:
"Exile II: Escape From The Pit"................................................................NO                YES                  ($25)
"Exile II Character Editor".........................................................................NO                YES                  ($9)
"Exile: Escape From The Pit"....................................................................NO                YES                  ($25)
"Exile Character Editor".............................................................................NO                YES                  ($9)

I would like to order by mail:
The hint booklet to Exile II........................................................................NO                YES                    ($7)
Send a copy of "Exile II" and the Exile Editor on disk............................NO                YES                    ($6)
      (this is only available by mail)
The hint booklet to Exile............................................................................NO                YES                    ($6)
Send a copy of "Exile" and the Exile Editor on disk................................NO                YES                    ($6)
      (this is only available by mail)

Exile II Bundle: Exile II, the Editor, and a Hint Book............................NO                YES                  ($35)
Exile Bundle: Exile, the Editor, and a Hint Book....................................NO                YES                  ($35)

Total so far:                                                                                                                                                                                                      
______________

Outside US and Canada add $3 shipping and handling                                                          ______________

NJ residents add %6 sales tax                                                                                                                                            
______________

Total:                                                                                                                                                                                                                     
______________
My e-mail address is:



America Online                                                                                                

Compuserve                                                                                                                                

Internet                                                                                                                                                        

Other                                                                                                                                                                
Circle the name of the service you would like us to try and e-mail your registration    to.



 Getting 256 Colors

Exile II is unusual among Windows games in that its graphics are designed for 256 colors. Should the 
graphics come up looking utterly bizarre, it is likely that your system is not currently set for 256 colors. Following 
these directions should fix the problem:

1. Go to the Program Manager.
2. In the Main directory, run Windows Setup
3. In the Options menu, select Change System Settings.
4. You will be changing the Display setting, using the arrow control to the right. Select one of the settings that 
mentions 256 colors. Your best bet will probably be Super VGA 640x480 256 colors.
5. Hit OK, and follow the instructions youre given.
6. Restart the machine. Exile II should be in living, vibrant color.
7. Doesnt that look much nicer? Have fun!

When being run, Exile II takes over the colors in a system palette. Because of this, other applications may look 
somewhat odd. They will switch back to normal when Exile II stops running.



 Using the Editor

How to use the editor.

          The Exile II editor is very easy to use. To do so,
1. Run it.
2. Select Restore from the File menu.
3. Select the save file to edit.
4. Make the changes.
5. Select Save from the File menu.

          To make a change, press one of the other buttons. Their uses are described in the next five chapters. Note, 
however, if you, in an unregistered copy, selecting any option not in the Free Extras menu prevents you from saving 
that party.

A Serious Warning

          The Exile II Editor is a powerful utility. And, as has been said, "With great power comes great responsibility." 
It is not only possible, but in fact quite easy to use the editor to make the game unwinnable. All you need to do is 
dispose of the wrong item, or rub away the memory of the wrong piece of information. The editor can also correct 
the damage, of course. But as a rule of thumb, it is best to 
      1. Be careful, 
      2. ALWAYS keep an unaltered back-up save file, and
      3. Only do positive things with the editor. It's generally safe to give yourself new information or a new item, but 
very risky to take things away.

Fun Editor Suggestions

          Many uses of the editor are obvious, of course. Getting that pesky Dispel Barrier spell, or unkilling a dragon 
that had some valuable info are two obvious possibilities. Also, gold is often scarce early in the game, and the Editor
provides generous (and low-interest!) loans. There are plenty of other uses too...

1. Exile II is huge. Some people just don't want to spend the considerable amount of time to see all the scenery with 
a standard party. Get a really powerful party, and you can see the sights very easily. Trust me - even with a very 
powerful band the game is still a challenge.
2. Try making one really, really powerful character, and see how far that lone person can get.
3. If you go into Chapter II too early, the unregistered version of the editor can return you to the
start and reset the boat in chapter 2.

Editing Options:

When you load a party in, each PC will have four buttons next to it, each of which is used for a different 
editing feature:

Race:    This button is used not only to change a PCs race, but to change his/her advantages and disadvantages as 
well. Click on the light to the right of a trait to add/drop it.

Note that adding an advantage does not make you immune to the effects of having that trait on your rate of 
gaining levels.

Train:    After pressing this button, you can change your character's skills however you want. It's like training in the 



regular game, but you don't have to pay for it.

Items:    From this window you can identify and drop items, and, more importantly, add whatever items you want. 
Click the button by an item to add it. Read the next section for descriptions of the various items.

Spells:    You can add (or take away) any mage and priest spell. Click this button, select mage or priest spells, and 
click the buttons by the spells to add/drop them.



 The Editor Menus

Most of the Exile II Editor's features (and all of the free features) are activated through the menus. Options 
in the Free Extras menu can be used in the unregistered editor. Options in the Edit Party menu can only be used after
you register.

File Menu:
Save - Records the changes you've made. If the editor is

unregistered and you've used features not in the Free Extras 
menu, this won't work.

Load Party - Reads one of your save files in for editing.
Quit - When you're ready to get back to business.

Registration:
Registration Info - Tells how to register and give the 

registration code you need to provide when you register.
Register This Copy - When you've registered, select this

option and input your key to register the editor.

Free Extras:    (All the stuff you can use without paying.)
Gold/Food/Healing:    The most important free option! This

brings up a window from which you can input how much gold 
and food you want your party to have. Pressing the 'Heal
Party' button heals all of your PCs damage.

Leave Town - Should you become trapped in a town, say by a 
horde of guards between you and the exit, selecting this option 
moves your party to the dungeon entrance. Things you did in 
the dungeon will not be recorded, and your maps will not be 
saved. Stuff you got will remain yours.

Reunite Party - Sometimes your party gets split up in
dungeons. Selecting this option reunites them.

Unkill Dragons - Some dragons know things you need to hear. 
Killing the dragons before hearing them causes problems. 
Selecting this option causes all the dragons to become alive 
again. Next time be a nicer person!

Return Party To Start - You can only use this option on a 
save file for a party that is outdoors and not in a boat. It takes
your party and returns it to just outside Fort Ganrick. 
Beware - if doing this leaves boats where you cannot get at 
them or past them, you can very easily make your game 
unwinnable.

Reset Chapter 2 Boat - This takes the boat you used in 
Chapter 2 and returns it to the town you found it in. Use this
option if you'd like to go through Chapter 2 again.

Edit Party:
Add Special Items:    This brings up a window from which 

you can give your party special items and maps, and complete
their quests for them. The things you can do are described in
a later section.

Add Alchemy:    This brings up a menu from which you can add
and delete knowledge of alchemical recipes. Click on the light



by a recipe to add it. Click again to delete it.



 Adding Items

When you select the "Items" button, a screen comes up with the inventory of the chosen PC and a list of the items 
you can add.
          To add items, click on the lights by their names. If you have too much stuff, click the button by an item to 
identify it and option-click the button to drop it.
          The items you can add are described below. Be warned - reading this list will give some game secrets away. 
Note that practically all of these items can be found in the game, but most are extremely rare.

Magic Halberd, Magic Great Mace, Magic Greatsword, Magic Broadsword, Magic Flail, Magic Wave Blade - No 
special abilities, just extremely rare and effective weapons.
Demonslayer - The incredibly hard to get and powerful artifact. The most reliable anti-demon item.
Alien Blade - Good greatsword, which also poisons whoever it strikes.
Leather Jerkin, Magic Studded Armor, Magic Chain Mail, Magic Breastplate, Magic Plate Mail - An excellent armor
selection.

Yew Bow, Magic Arrows - Effective missile weapons.
Arrows of Light - Demon-slaying arrows.
Arrows of Life - Undead-slaying arrows.
Flaming Javelins, Magic Darts - Effective thrown weapons.
Magic Bucker, Magic Shield, Magic Great Shield - Good shields. Note the magic buckler doesn't interfere with 
spell-casting.
Crystal Shield - Magic, protects from petrification.
Runeshield - An excellent shield, that doesn't encumber the user.
Lifeshield - Saves life when user killed. Excellent item.
Ice Shield - Magic, protects from fire.
Magic Helm, Magic Greathelm - Very rare and effective.
Speed Helm - Very rare and powerful helm - it increases the speed of the user in combat.
Magic Gauntlets - Really good gauntlets.
Giantish Gauntlets - Good gauntlets, which also make the wearer much more effective in melee.
Micah's Gloves - These gloves make the wearer's spells more effective. Extremely rare.
Nimble Gloves - Make the wearer better at picking locks and disarming traps.
Wand of Death, Wand of Nullity, Wand of Charming - Casts relevant spell.
Prismatic Wand - Damages demonkind.
Graymold Salve - Rare and effective healing salve. Problem is finding right place to use it. When used, it cures 
disease on the entire party.
Magic Lockpicks - Gives large bonus in picking locks.
Shielding Crystal - Casts protection spells.
Fire Lizard Eggs - The object of a certain quest.
Ambrosia - Heals all of users damage.
Onyx Charm - Protects from magic and fire.
Ruby Charm - Protects from fire.
Orb of Thralni - Enables user to fly.
Lifesaver Amulet - Saves user when killed. Excellent item.
Ivory Charm - Protects wearer.
Gold Ring of Protection, Gold Ring of Skill, Gold Ring of Regeneration -    The best of their respective kinds.
Ring of Speed - Makes wearer move faster in combat.
Ring of Will - Protects wearer from dumbfounding and improves skill in mindduels.
Deli Sandwich - Yum!
Killer Poison - Standard supplies.
Magic Darts, Magic Bow, Magic Arrows - Good weapons.
Arrow of Returning - Magic arrow; not used up when fired.



Lightning Rods - Javelins which do extra damage.



 Adding Special Items

From this window, you can add or delete all of the special items you go to so much 
trouble to find while travelling through Exile. Most of these are self-explanatory - click by it to add it and click 
again to remove it. Take something important away, and you probably won't be able to finish the game. 

Clearance:    Clicking here you can change your parties security clearance.
Crystal Souls:    When you give yourself a crystal soul, it will be in your possession, but not placed where it 
eventually needs to go. Best not to select this after you've plalced the Crystal Soul in the shrine.
Maps:    You can give yourself the maps for anywhere in the game. There are three sizes of town: small, medium, 
and large, and outdoor areas you can reach in four different chapters. This option doesn't work on a save file that 
doesn't have maps stored in it. This option cannot be undone.
Reset Vahnatai Counter:    Suppose you send the Vahnatai troops marching out of Fort Haledon and then don't catch 
up with them? Select this and they will be placed back in the fort, ready for you to launch them again.
Giant Statues:    Selecting this option gives you all three of the statues you're asked to find in Fort Dranlon.
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